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TIPS-1
THE CURRENT DATE EVERY TIME

Experienced Word 97 users never type the current date. They usually insert it
manually by using Insert | Date And Time and then selecting one of the
predefined date (and/or time) format options.

However, extremely wise Word users set up their form documents so that they
never even have to insert the date or time. If you have a form letter that you use
frequently, Word can automatically insert the current date every time you print
the document.

Just use Insert | Date And Time like you normally would, but before you press
[Enter] or click OK to insert the date or time, click the check box for the Insert As
Field option. (You'll find it in the bottom-left corner of the Date And Time dialog
box.)

Word will insert the current date every time you print that document. If the option
is off when you make the insertion, the initial date remains fixed (set at the
current date as of the moment you inserted the field).

You can accomplish the same effect by using Insert | Field | Date And Time and
selecting Date from the Field Names list.

TIPS-2

UNLEASH THE POWER OF [F8]

Here's a shortcut that many Word users overlook: [F8], which toggles the Extend
Selection mode. (You can also toggle the Extend Selection mode by double-
clicking on EXT in Word's status bar.)

Here's how it works:
*. Press [F8] once to turn on Extend Selection mode.

*. Press [F8] a second time to highlight the word where the cursor is
located.

*. Press [F8] a third time to select the sentence that contains the
word you just selected.

*. Press [F8] again to highlight the current paragraph.

*. Press [F8] one more time to select the entire document.



And that's not all, folks. Pressing [F8] lets you quickly select text by pressing any
letter, punctuation mark, or navigation key.

To demonstrate this feature, say you want to select all the text from the cursor to
the end of the current paragraph: Press [F8] and then hit [Enter]. Now, click
anywhere in the document and type a letter. When you do, Word will start with
the location of the cursor and select the text up to and including the letter you
typed. While Extend Selection is on, you can keep typing the same character (or
any other) to extend the selection. You can also press the arrow keys to select
text in any direction.

To turn the Extend Selection mode off, press [Esc] or [F8] or double-click on EXT
in the status bar.

TIPS-3

ADDING TABLE ROWS IN WORD 97, PART 1 OF 3

It's a law: After you set up a table in Word 97, you'll eventually have to add new
rows. Many novice Word users soon discover that adding rows isn't as easy as it
sounds. Here's the first in a series of three tips that you can share with your
users on how to add rows in Word tables.

INSERT ONE ROW IN THE MIDDLE OF THE TABLE

The three ways to add a row in the middle of a table are: the Table menu's Insert
Rows options, the Standard toolbar's Insert Rows button, and the right-click
menu's Insert Rows option. (Despite the names, the Insert Rows button and the
Insert Rows menu options by default insert only one row at a time.)

Start by clicking anywhere on the row below where you want the new row to
appear. Then click the Insert Rows button, right-click, and select Insert Rows
from the Context menu. You can also issue the command Table | Insert Rows.
When you do, Word will put the new row ABOVE the row where you placed the
cursor. (If you inadvertently insert the new row in the wrong place, just press
[Ctrl]+Z or hit the Undo button to delete that row.)

Many Word users overlook the Insert Rows toolbar shortcut because the button
appears on the Standard toolbar ONLY when the cursor is on an existing table.
(When the cursor is not on a table, the Insert Rows button changes to the Insert
Table button.)

In tomorrow's tip, we'll cover how to insert two or more rows at a time.

TIPS-4

ADDING TABLE ROWS IN WORD 97, PART 2 OF 3

Yesterday, we showed you three methods you could use to teach your Word 97
users how to insert a row in the middle of an existing table. But what if they need
to insert two or more rows in the middle of a table? They could:




* Click the Insert Rows button several times in a row.
* Right-click on a row and choose Insert Rows several times in a row.

* Issue the command Table | Insert Rows once and then press [Ctrl]+Y to
"repeat" that

command and insert new rows.

Fortunately, Word provides an elegant shortcut for inserting two or more rows at
once. Simply select the number of rows to insert. Then, click the Insert Rows
button (or issue the appropriate command), and Word will insert as many new
rows as your user indicated. (For example, if they select three rows and click
Insert Rows, Word will insert three blank rows into the table.)

When inserting a single row, Word puts the new row ABOVE the row where the
cursor was placed. As you'd expect, when your users select multiple rows, Word
inserts the new rows above the topmost row in the selection.

NOTE: Remind your users that they must select entire rows. If only one or two
columns are selected, Word will display the Insert Cells dialog box instead of
inserting the rows immediately.

The final part of this series will cover how to add rows below the cursor and at
the bottom of the table.

TIPS-5

ADDING TABLE ROWS IN WORD 97, PART 3 OF 3

In the past two days, we've shown you several ways to insert one or more rows
within an existing Word table. In this final tip of the series, we'll show you one
more way to add a single row in the middle

of a table and how to insert rows at the bottom of a table.

ADD A ROW BELOW THE CURSOR

With the "Insert Rows" approach, Word inserts the new row above the row where
you'd placed the cursor. But what if you want to insert a row below the row on
which you've clicked?

As you probably know, if you press [Enter] while editing text in a table cell, Word
begins a new paragraph the same way it does when you're editing plain text.
However, there is a trick that lets you use the [Enter] key to insert a new row.

You first must click just outside the far-right edge of a table row, between the
table border and that nonprintable character that indicates the end of the table
row. Then, when you press [Enter], Word inserts a new row below where you



started.

ADD A ROW AT THE TABLE BOTTOM

The last way to add a row to a table row is to click anywhere on the last row and
press [Tab] through the last column. When you tab out of that column, Word
adds a new row to the bottom of the table.

TIPS-6

ADDING A CLOSE BUTTON

In Word 97 and 2000, your users can open the Open dialog, save the current file,
or print the open document with one click of the mouse. But what if they want to
CLOSE the current document? That would require going to File | Close or
clicking the document's Close Window button.

Although the Close button lets you close a document with a single click, many
Word users prefer to keep their frequently used shortcuts on the left side of the
toolbar. Fortunately, it's easy to add a Close button to the Standard toolbar.
Here's how.

Go to View | Toolbars and select the Customize option. Click the Commands tab,
and select File in the Categories drop-down list box. Then, in the Commands list
box, click on the Close icon and drag it onto your Standard toolbar. When your
mouse gets close to the toolbar, the "X" under the mouse will change to a plus
sign (+), indicating that releasing the mouse will put the shortcut icon on the
toolbar. Once you've "dropped" the icon onto the toolbar, simply click Close to
dismiss the Customize dialog box.

TIPS-7

SAVE TIME WITH CLOSE ALL AND SAVE ALL

In yesterday's tip entitled "Adding a Close button," we showed you how to
customize your Standard toolbar by adding a Close button. Your users will
appreciate having the Close button in the same toolbar neighborhood as the
New, Open, and Save buttons.

Unfortunately, the Close button only affects one document at a time. But suppose
your users are working on five or six documents, and they want to close or save
all of them at once? Here's the solution you can share with your Word 97 and
2000 users: Hold down the [Shift] key while clicking on the File menu. (Note: This
trick won't work if you try to

display the File menu using the [Alt]F shortcut.)

When you hold down the [Shift] key and click on File, Word adds two new options
to the File menu: Close All and Save All. When you select Close All, Word will
start the process of closing all of your open documents, prompting you about
saving changes when appropriate. You can interrupt this process at any point by
clicking the Cancel button. When you select Save All, Word saves the most



recent versions of all of your documents (without confirmation) but leaves the
documents open.

Not only will this tip save your users time, but it also ensures that they won't lose
their work!

TIPS-8

RENAMING AUTOTEXT ENTRIES

Since you're experienced in Word, you're probably a big fan of AutoText. This
feature lets you replace short abbreviations with words, phrases, or even graphic
images. You can type the AutoText abbreviation and press [F3]. Or, if you've
activated AutoText's AutoComplete feature, Word will suggest AutoText when it
detects that you've started

typing an AutoText entry, and you can press [Enter] to complete that entry. (To
view the AutoComplete checkbox, use Tools | AutoCorrect and click the AutoText
tab.)

Problems can arise when you want to rename an AutoText entry. Open the Insert
menu and select AutoText twice, which opens the AutoCorrect dialog box with
the AutoText tab displayed. Notice that the AutoText tab offers Add, Delete, and
Insert buttons, but no Rename. Unfortunately, many users will resort to
unnecessarily recreating an AutoText entry from scratch. Inform them that Word
offers an easy way to rename AutoText entries.

First, open the Format menu and select Style. Once the Style dialog box
appears, click the Organizer button, and select the AutoText tab. Now, choose
the appropriate template (e.g. Normal.dot) in the AutoText Available In dialog
box. Locate and click on the entry you want to change in the "In" (appropriate
template) field. Select the Rename button, type the New Name, and click OK.
That's all there is to it!

TIPS-9

NUMBERING WITH LEAD ZEROES

Numbering items in a list is a breeze in Word. All you have to do is go to Format |
Bullets and Numbering | Numbered and select a numbering style. Then, each
time you press [Enter], Word will automatically number the new line. (If you press
[Enter] a second time without typing any text, Word will assume you're finished
with the numbered list and remove the number on that line.)

The default numbering style doesn't include leading zeroes. However, if you or
your users want lead zeroes, Word provides a built-in style that addresses this
very problem. To access it, go to Format | Bullets and Numbering | Numbered,
select one of the numbered options, and then click the Customize button to open
the Customize Numbered List dialog box. Go to the Number Style drop-down list
box and select the style that begins 01, 02, 03... When you apply this option,
Word automatically pads the single digits with a leading zero. If you need more



than one leading zero, just click in the Number Format field and add the extra
zero on the left side of the existing two-digit style.

Back to TOP

TIPS-10

HOW TO KEEP A JOURNAL IN WORD, PART 1 OF 4

Keeping a journal of your daily experiences isn't easy. You must make time to
write down your journal entries by hand or key each of them into a document. But
remember that no matter how you create it, you must secure your journal to keep
it private. Today, we begin a series on how to use Word to create and protect
your electronic diary.

First, you can use the "big giant document" approach to creating your journal. For
example, suppose you create one document named "Mylife" and enter each new
entry at the bottom of the document.

* PROS: The best thing about the single document journal is its simplicity. Also,
making a backup copy of the document is easy because you only have one
filename to worry about. And if you want to review previous entries, they're all
right there in front of you--there's no fussing with opening additional Word
documents. To label entries according to the time they were entered in the
journal, go to Insert | Date And Time and select one of the formats that are
available.

* CONS: The main problem with the single document method is that if you delete
or damage the document, you lose everything. Therefore, your disaster recovery
plan should include frequently making a safe, reliable backup copy of your ever-
expanding journal.

Next time: The multiple document approach.

TIPS-11

HOW TO KEEP A JOURNAL IN WORD, PART 2 OF 4

Yesterday, we presented some pros and cons for using a single document to keep a
personal (or business) journal. Today, let's look at using multiple documents.

Instead of working from a single document, create files with names that identify the time
during which you made the journal entries. For instance, you could use Mylife2000,
Mylife2001, and Mylife2002 to group a year's worth of entries together. How about
making monthly files in a similar fashion, adding the two-digit month (01-12) to the
filename?

* PROS: Some Word users just don't like navigating in documents that are too large.
Those users might be more inclined to keep smaller daily, weekly, or monthly journal
files. And if it's not likely that they will go back and reread their journal entries, archiving



smaller files as they go may be the answer. The only time they'll have to handle those
files again is if they decide to look up an old entry.

* CONS: There's a trade-off for using multiple files. Keeping track of multiple journal
documents requires more time and effort than maintaining a single file. Searching and
reviewing old journal entries takes more time, too. Also, when backup sets are created,
there are more files to deal with. Think about it: You must open the old files or use the
Open dialog's Text or Property option to pinpoint certain files. Either way takes longer
than searching a single document.

Stay tuned because tomorrow we're going to fill you in on how to keep your journals safe
from disaster.

TIPS-12

HOW TO KEEP A JOURNAL IN WORD, PART 3 OF 4

In the first and second installments in this series, we went over several approaches for
keeping a personal or business journal in Word. Whether you use a single- or multiple-
document approach, there's one detail you must take into consideration: file security.

Even if someone gains unauthorized access to a user's computer, you can take measures
to protect their privacy. First and foremost, make a reliable backup copy of their file (or
files) and put it in a secure place. Now, if a computer is stolen or suffers an unrecoverable
data loss, you can copy files onto a new computer from the backup media.

Here are two tips for making quick backups:

* Use File | Save As and change the Save In option to the computer's floppy drive. Click
the Save button and then put that disk somewhere safe.

* E-mail the file to yourself as an attachment. If you don't have a secure e-mail address at
home or at work, establish an account with one of the free Web-based e-mail services.

Tomorrow we'll clue you in on how to protect your journals from prying eyes.

TIPS-13

HOW TO KEEP A JOURNAL IN WORD, PART 4 OF 4

In this series, we've talked about using single or multiple documents to maintain a
personal or business journal. In part three, we told you how to make a copy of your
journal for a rainy day. Now, in this final installment, we'll explain how Word makes it
easy to protect your journal from prying eyes.

If someone gains unauthorized access to your computer, you can foil their attempts to
open any of your journal documents. Just use Word's password-protection feature to lock

everyone out but you.

To create a password for your document, use File | Save As, go to the Tools drop-down



list, and click the General Options button. In the File Sharing Options For section, enter a
unique password in the Password To Open field, and then click OK. When you do, Word
will ask you to confirm the password. Enter your password again and click OK. Then,
click the Save button to dismiss the Save As dialog box.

The next time you attempt to open that document, Word will prompt you to enter the
password. Anyone who can't provide the correct password will see a message with the
yellow triangle and the exclamation point that says, "The password is incorrect. Word
cannot open the document."

TIPS-14

SETTING TABS AND MARGINS PRECISELY

Using the menu system to set tab stops and fine-tuning document margins can be a real
chore for many Word users. Using File | Page Setup to change margins and Format |
Paragraph | Tabs to tweak tab stops is a text-based process.

Visually oriented Word users will like this graphical tool for setting tab stops and
margins. (You must display the ruler to use this tip, so if it isn't visible, go to View |
Ruler.)

To see your tab options (Left, Center, Decimal, and Right), just click on the tab icon on
the far-left edge of the ruler. Each time you click the icon, the tab style will change.
(Hold the mouse over the icon if you want to view the tip text that identifies each type.)
To set a tab, click anywhere on the ruler, and Word will set a tab stop. If you want to
remove a tab stop, click on it and drag it off the ruler.

AND NOW THE BEST PART

Would you like to know the precise position of the tab stop? All you have to do is hold
down [Alt] and click the tab marker on the ruler. While you're holding down [Alt] and
dragging the mouse to the left or right, Word will display the tab's position as well as the
distance between the tab and the left and right margins.

The same trick applies to the ruler's left and right margin icons. Hold down the [Alt] key
while you click and drag those items, and Word will display the margin settings precisely

TIPS-15

GRANTING READ-ONLY PRIVILEGES

In the Dec. 7, 2000 tip, "How to keep a journal in Word, part 4 of 4," we showed you
how Word's password-protection feature helps keep your sensitive documents safe from
snoops. (You use File | Save As, go to Tools and select General Options from the drop-
down list. Then, in the File Sharing Options For section, type a password in the Password
To Open field.) With this approach under your belt, you'll be the only person who can
open that file!

Sometimes, however, you'll want a select group of people to have access to a document.
For instance, suppose you want to allow five coworkers to open and review your



password-protected file. You just tell them the password, right?
But in cases such as this, you probably don't want coworkers EDITING your file. In

effect, you want to grant Read-only permissions to your password-protected file. To do
so, use File | Save As, go to Tools, select General Options from the drop-down list, and
enter the document's password. Now, type a different password in the Password To
Modify field and reenter this password when Word prompts you to confirm it.

This way, your coworkers can open the file with the main password, but they will still be
restricted from editing the file unless you give them the second password.

TIPS-16

DRAW IT OUT

Are your users having problems with the Drawing toolbar's objects? Do their images
sometimes appear skewed when the mouse is moved? It's time we let you in on the secret
for creating perfectly proportioned drawing objects in Word documents.

The Drawing toolbar's AutoShapes feature lets you draw lines, arrows, callouts, and
many other useful shapes for adding visual pizzazz to your documents. You can even
create your own shapes using the Rectangle, Oval, and Text Box tools. All you have to
do is click on a tool, and then click-and-drag it to create the object, right?

Well, many Word users have problems moving the mouse in a straight line. If they want
to create a drawing object that retains its proportions--say, for example when they want to
draw a perfect square or circle--tell them that they just need to add the [Shift] key.

We'll show you what we mean: Select the drawing object (or click on the Text Box), and
press and hold [Shift] before you click to start the drawing. If you click the Rectangle
tool, you'll draw a perfect square (instead of a rectangle). If you click the Oval tool and
click-and-drag, you'll create a perfect circle.

TIPS-17

WHO SAYS YOU HAVE TO BE NORMAL?

IT departments love standardization. They "ghost" an image to a new machine when a
user system crashes. Many Office administrators customize the Normal.dot template as a
part of that standard image. That way, your training and support personnel only have to
support one official version or Normal.dot.

In practice, however, people across different departments in an enterprise have specific
needs for their "standard" templates. Fortunately, there's an elegant and simple way to
support several different Normal.dot files in your organization: Customize Normal.dot
and then save the file under a different name, such as NormalAccounting.dot,
NormalMarketing.dot, or NormalQA.dot. If a machine crashes or a new user is hired in
one of those departments, you can easily install a copy of the custom template under the
Normal.dot name.



Many of your users will want to create files based on different "normal" templates at
different times. Instruct those users to save all of those "custom Normals" under their
custom filenames in an appropriate template directory.

TIPS-18

WHO SAYS YOU HAVE TO BE NORMAL?

IT departments love standardization. They "ghost" an image to a new machine when a
user system crashes. Many Office administrators customize the Normal.dot template as a
part of that standard image. That way, your training and support personnel only have to
support one official version or Normal.dot.

In practice, however, people across different departments in an enterprise have specific
needs for their "standard" templates. Fortunately, there's an elegant and simple way to
support several different Normal.dot files in your organization: Customize Normal.dot
and then save the file under a different name, such as NormalAccounting.dot,
NormalMarketing.dot, or NormalQA.dot. If a machine crashes or a new user is hired in
one of those departments, you can easily install a copy of the custom template under the
Normal.dot name.

Many of your users will want to create files based on different "normal" templates at
different times. Instruct those users to save all of those "custom Normals" under their
custom filenames in an appropriate template directory.

TIPS-19

CANIQUOTE YOU ON THAT?

Creating newsletters, promotional brochures, or other publications? Here's a time-
honored trick for grabbing the eye and pulling the reader into your text: Use a pull quote!
Here are specific instructions for both Word 97 and 2000.

In Word 97, use the Drawing Toolbar's Text Box tool to add a text box to your document.
Right-click on the border of the box and choose Format Text Box. Click the Wrapping
tab and select a Wrapping Style option. Since we're dealing with a text box, the Square,
Tight, and Through options will have the same effect (wrapping text around the perimeter
of the box). If you prefer, you can choose the Top & Bottom option to wrap text above
and below the text box. Now, select a Wrap Tooption. This is where you can tell Word to
wrap text along either side,the side with the most text, or both sides of the text box.

Now for you Word 2000 folks, use the Drawing Toolbar's Text Box tool to add a text box
to your document. Right-click on the border of the box and choose Format Text Box.
Click the Layout tab and activate a Wrapping Style and the Horizontal Alignment. If you
want to be more specific about the wrapping style you want, select the Advanced button.
Under the Picture Position tab, you'll see specific choices for Horizontal and Vertical
positioning as well as other Options. If you click on the Text Wrapping button, you can
tell Word where to wrap the text, such as Behind or Through, in relation to the text box.



If you haven't already done so, select your quote. Then type or paste it into the text box,
using quotation marks or whatever punctuation is appropriate. Many people who use this
feature often italicize, bold, and enlarge the quote for additional emphasis.

TIPS-20

SPAN A HEADLINE ACROSS COLUMNS

Word makes it easy to format newspaper- or magazine-style documents. Just turn on the
Columns feature, and Word will "snake" your text through the prescribed number of
columns. But what about page one, or "special" pages like chapter or article titles? For
those pages, you'll want to create a title or headline that's in single-column mode and
spans across your two- or three-column layout.

You'll be pleasantly surprised to see that spanning a headline across columns is incredibly
easy. First, insert a continuous section break at the top of your document. Since you want
to format the headline section as a single column, enter images and extra-large text you
want for your headline in that first section.

Next, click anywhere in the second section, hit the Columns button on the Standard
toolbar, and select two (or more) columns. When you release the mouse button, Word
will immediately apply that multicolumn format to the second section of your document.

NOTE: You need to be in the Print Layout view to see the WISYWYG effect of the
Columns setting.



